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This file lists all changes made to SAP2000 since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant. 

Changes from v18.2.0 (Released 2016-08-19) 

User Interface 
Enhancements Implemented 

* Incident Description 

 13537 A change was made to the terminology for certain steel material properties, changing from 

"effective" to "expected" stress values. This is only a change of wording in the user interface and 

documentation to be more consistent with current codes and standards. 

 95060 An enhancement was implemented to enhance several of the edit menu forms to allow them to 

remain open for repetitive use with a new apply button. 

 95728 An enhancement was implemented to improve the speed of the Set 2D View form for large models. 

A feature was also added to determine the plane from a single click on the drawing form. 

 97401 The Edit > Show Duplicates command has been changed to Select Duplicates. Previously, the Show 

Duplicates command highlighted objects of the same type that had the same connectivity by 

displaying them in a magenta color, but this color would disappear upon moving the mouse. The 

new command will highlight the duplicated objects by selecting them instead. This has the added 

advantage that they can be shown alone without the rest of the model (command Show Selection 

Only), displayed in a table, or otherwise manipulated. Another change was made to the "Merge 

Duplicates" command in that it will no longer merge joints in the same location that have different 

merge numbers. This is different from the "Select Duplicates" command which will select joints in 

the same location irrespective of the merge numbers. 

Modeling 
Enhancements Implemented 

* Incident Description 

* 18878 

37418 

45772 

An enhancement has been implemented to expand and enhance the hysteresis models for nonlinear 

energy dissipation. This enhancements applies to the nonlinear materials used in fiber hinges and 

the layered shell, to single degree-of-freedom (non-interacting) frame hinges, and to the multi-

linear plastic link. These hysteresis models include: (1) Isotropic model, which dissipates the most 

energy; this was previously available only for frame hinges.  (2) Kinematic model, typically 

suitable for metals; this was previously available. (3) Takeda model for simple degradation; this 

was previously available. (4) Pivot model, typically for reinforced concrete; this was previously 

available for hinges and links but not materials; the reloading behavior has been slightly modified 

so as to load from the pivot point to the backbone curve along the secant line, rather than along the 

backbone curve as done previously. (5) Concrete model, representing compression and tension 

behavior differently; this is new and similar to the model in Perform-3D; it can also be used in 

reverse to represent tension-only behavior. (6) Degrading model, capturing energy and stiffness 

degradation with kinematic behavior; this is new and similar to the model in Perform-3D. (7) BRB 

Hardening model, for representing buckling-restrained braces; this is new and similar to the model 
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* Incident Description 

in Perform3D. The behavior of the existing models has been improved for the cyclic behavior 

during strength loss. 

 58601 An enhancement has been implemented to add A500 Grade C steel to the United States material 

library. 

 67569 An enhancement has been made to update the frame hinge definitions to follow ASCE 41-13 

guidelines. Older files with automated FEMA hinges will now follow the new guidelines. Also the 

performance point calculations for pushover curves have been updated to ASCE 41-13. 

* 86202 A new parametric P-M2-M3 frame hinge has been implemented for use with performance-based 

design and other types of nonlinear analysis. This hinge can be used for double-symmetric steel and 

reinforced-concrete frame sections. The axial capacity can be different in tension and compression. 

The P-M2-M3 interaction surface is assumed to be smooth and is represented by a few simple 

parameters. Strength loss and energy degradation can be captured. Deformation capacities can be 

defined and reported as part of the performance checks. Parametric P-M2-M3 hinge properties can 

be user-defined or automatically created from frame sections. 

Section Designer 
Enhancements Implemented 

* Incident Description 

 94580 An enhancement has been implemented to import sections from DXF files into Section 

Designer. A list of importable entity types and the layers they are on in the DXF file is 

presented to the user. The user can specify the layers and the entity types from those layers to 

be imported and what Section Designer entities they should be mapped onto. As necessary, 

based on entity mapping, other parameters such as material, thickness, rebar designation, 

spacing, etc. can also be specified. 

Loading 
Enhancements Implemented 

* Incident Description 

 94048 An enhancement has been implemented to add automated wind load, seismic load, and response-

spectrum function according to the NBCC 2015 code. 

 95555 An enhancement was implemented to ignore marine growth when calculating buoyancy forces and 

also assume buoyancy forces to be zero for flooded objects. 

Frame Design 
Enhancements Implemented 

* Incident Description 

 31923 An enhancement was implemented for "Eurocode 2-2004" and "Italian NTC 2008" codes 

concrete frame design to provide a new overwrite for the value of tan(theta) (theta=angle 

between the concrete compression strut and the beam axis perpendicular to the shear force) 

which is used in the shear reinforcement calculation. 

 96435 The automatic calculation of K-factors during frame design now accounts for the effect of 

frame property modifiers, whether assigned to frame objects or defined in frame section 

properties, or both. The K-factors computed for the frame object being designed can be affected 

by the relative stiffness of connected elements, and this is what has changed under this 

enhancement. Frame design results may be different in the present release compared to 

previous versions due to this change. No other results are affected. 

 96699 An enhancement was implemented to reinstate the Italian UNI 10011 steel frame design. This 

was previously removed in v18.0.0. 
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Analysis 
Enhancements Implemented 

* Incident Description 

 45404 

76493 

An enhancement has been implemented that provides two alternatives to how frame nonlinear 

hinges are represented in the analysis model. Previously the hinge was internal to the frame 

element, but now the hinges may be modeled instead as a zero-length link elements connecting 

multiple frame elements that represent the full length of the member. The main reason for doing 

this is to allow nonlinear modal time-history analysis (Fast Nonlinear Analysis, FNA) to 

account for nonlinearities in frame hinges, as well as to provide more damping control for 

nonlinear direct-integration time-history analysis. This new feature are available only with the 

Ultimate license level. This change has several implications:  (1) When performing FNA for 

such a model, it is important to use Ritz modal analysis to capture the modes that represent the 

link nonlinear deformations.  (2) This approach introduces a very small amount of elastic 

flexibility at the hinge locations, which may cause slight differences in both linear and 

nonlinear behavior compared to a frame member without hinges. For the same reason, slight 

differences in results for all load cases may be expected from previous versions of SAP2000 in 

models having frame hinges. Isotropic hinges will now be slightly more flexible (previously 

they were rigid before yield), fiber and non-isotropic hinges will be slightly less flexible (these 

previously had some flexibility before yield).  (3) Additional rotational mass degrees of 

freedom may be present at the hinge locations.  (4) Convergence behavior should generally be 

improved for nonlinear static and direct-integration time-history load cases, particularly for 

cases where multiple hinges in the same frame object were dropping load at the same time.  (5) 

For hinges modeled as links, the stiffness-proportional damping used for direct-integration 

time-history analyses may now be specified by the user to be proportional to the initial stiffness 

of the hinge (the current behavior), the tangent stiffness, or a mixture of the two. Tangent-

stiffness damping is generally more realistic, but may increase computation time. Initial-

stiffness damping generally leads to faster convergence during analysis, but may overestimate 

damping and hence be unconservative. 

* 

 

95529 The size of the saved analysis results files has been reduced for multi-step nonlinear static and 

nonlinear direct-integration time-history load cases. This will reduce the amount of disk space 

required for these types of load cases in models using non-isotropic single degree of freedom 

frame hinges, fiber P-M-M frame hinges, directional layered shell elements, and/or nonlinear 

link elements. Linear elastic shell and solid elements will also exhibit some reduction in disk-

space requirements. This may also result in some speed increase when running the analysis and 

displaying results, particularly for load cases with many steps. The amount of data saved will 

be reduced for other types of elements in subsequent releases of the product. 

Results Display and Output 
Enhancements Implemented 

* Incident Description 

* 40433 

43668 

47298 

55092 

Step-by-step energy plots are now available for nonlinear direct-integration time-history load cases 

and for nonlinear static/staged-construction load cases. Previously they were only available for 

linear and nonlinear modal time-history cases. In addition, plots of the input ground accelerations 

and/or load function are now available for nonlinear direct-integration time-history and nonlinear 

static load cases. 

Application Programming Interface 
Enhancements Implemented 

* Incident Description 

 97339 An enhancement has been implemented to provide v18 API compatibility in v19. Tools built 

against the v18 API should continue to work in v19 without the need to change references or 

recompile. 
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* Incident Description 

 97377 An enhancement has been implemented to add API functions for concrete frame design 

preferences and overwrites for the Hong Kong 2013 and TS 500-2000 codes. 

External Import/Export 
Enhancements Implemented 

* Incident Description 

 91404 An enhancement has been implemented to export curved frame members to the EXR file used 

by CSiXRevit. 

Miscellaneous 
Enhancements Implemented 

* Incident Description 

 95226 The version number has been changed to v19.0.0 for a new major update. 
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User Interface and Display 
Incidents Resolved 

* Incident Description 

 93725 An incident has been resolved in which an abnormal termination could occur when trying to 

manipulate data in the table for an advanced extrusion path (command Edit > Extrude > 

Extrude {Objects} to {Objects} > Advanced > Define/Modify Path). This was a user interface 

error and did not affect analysis or design results. 

 94548 An incident was resolved in which an abnormal error would occur on the staged construction 

load case definition form if a stage was defined with no stage data and the Modify button for 

the stage data was clicked. This was a user interface issue only and did not affect results. 

 95197 An incident was resolved when area or line springs were assigned to the model, and no link 

objects were assigned to the model, then when creating the analysis model the visibility of the 

link elements that were created to model the line or area springs from the Display Options form 

could not be controlled because the appropriate checkbox was not enabled. 

 95864 

96680 

An incident was resolved in which the program would terminate if a minimum value was 

specified larger than a maximum value, or in certain cases when two windowed selections were 

made on the View > Set Limits form. This was a user interface issue only and did not affect 

results. 

 95757 An incident has been resolved in which some of the preference and overwrite items were not 

conditionally activated or deactivated when changing other items on the form.   

Graphics 
Incidents Resolved 

* Incident Description 

 88656 An incident was resolved for models containing solid objects in which saving the model with 

the option to not show the solids in the view and then reopening it would result in an abnormal 

termination. 

 93176 An incident was resolved in which the display of the uniform to frame resultant area loading 

was not correct on certain members. This was a display issue only. This was previously fixed in 

v18.2.0 but inadvertently excluded from the release notes. 

 96016 An incident was resolved in which the graphical display of applied lateral loads was not 

working. This was a graphical issue only and did not affect results. 

 96098 An incident was resolved in which the graphical display was not updated to show selected area 

objects when using the Select > Select > Labels command. This was a graphical issue only. 

 96132 An incident was resolved where area surface pressure loads applied to the bottom face of an 

area object were not displayed correctly using the Display Load Assigns by Load Pattern – All 

Objects form. When surface pressure loads on the bottom face were specified to be displayed 

the program showed loads on the top face. 

Drafting 
Incidents Resolved 

* Incident Description 

 96895 An incident was resolved in which solid objects would get selected using on-screen selection tools 

even when they were set to not be in view. This was inconsistent with how other objects were 

working. 

Modeling 
Incidents Resolved 

* Incident Description 

 94231 

96686 

An incident was resolved in which an error was generated when assigning a joint pattern in certain 

models. 
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Section Designer 
Incidents Resolved 

* Incident Description 

 94833 An incident was resolved for Section Designer where the stress units were not converted 

correctly in the Steel Model Form such that stress value displayed at the bottom left corner of 

the steel stress-strain plot was not correct if the units were changed from the database units. 

Database units are those in effect when the model is first created and in effect each time the 

model is opened. This was a display issue only for the plot in this form and did not affect 

analysis results or any other display. 

 96094 An incident was resolved for section designer where the section properties and the geometry of 

a section designer section containing two or more box shapes could be calculated incorrectly if 

two of the box shapes were attached along one edge and aligned on another edge. This was not 

common. 

Loading 
Incidents Resolved 

* Incident Description 

 87448 An incident was resolved for concrete frame design according to ACI 318-11 in which some of the 

automated load combinations that corresponded to dead + live + static earthquake were generated 

blank. The combinations were generated properly if the design code was changed to ACI 318-14. 

The blank combinations were producing zero forces. The error was inadvertently introduced in 

v18.0.0. 

 94023 An incident was resolved where a combination that included seismic load as well as other lateral 

loads (wind or wave) may not get tagged as design type seismic and may not be considered for 

special seismic design requirements. This is not a common condition. 

 96129 

96592 

An incident was resolved in which the area load to frames was applied in the opposite direction than 

expected when specified to be applied in the gravity projected direction. 

 97248 An incident was resolved for the Peru NTE E.030 2014 response spectrum function where 

parameter Ip was also used for parameter R0 in the analysis instead of the specified R0 value in the 

function form. The results were overly conservative. A work around was to convert the Peru NTE 

E.030 2014 response spectrum function to user defined. 

Analysis 
Incidents Resolved 

* Incident Description 

 40905 An incident was resolved where nonlinear static load cases using displacement control would 

sometimes fail to run when loads were applied only to solid, plane, or asolid objects. When this 

occurred the analysis log file (.LOG) would indicate that the monitored displacement was zero 

for that load case, and no results were available for the affected case. 

 95495 An incident was resolved where the load assignment "Links - All" used for a modal load case 

(usually of type Ritz) was generating starting load vectors for all degrees of freedom (DOF) of 

link elements of type "Damper - Friction Spring", even when the DOF were linear or not 

selected. This had the effect of requiring more modes to achieve adequate static and dynamic 

load participation factors for the DOF that were actually nonlinear. Results were consistent with 

the modes calculated and the participation factors reported. 

 96077 An incident was resolved where the reported stresses and element joint forces for plane and 

asolid types of area objects excluded the effects of temperature and strain loads when applied in 

a nonlinear static or direct-integration time-history load case. The error in the joint forces 

affected reactions at joints connected to plane/asolid objects, as well as section cuts through 

these types of objects. The effect of temperature and strain loads applied to plane/asolid objects 

upon the rest of the structure was correct, including all displacements and forces or stresses in 

all other elements. Only the stresses in the loaded plane/asloid objects themselves were 
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* Incident Description 

affected, as well as the connected joint reactions and section cuts. Results reported for linear 

load cases were not affected, nor were nonlinear modal time-history (FNA) load cases. 

* 97759 An incident was resolved where incorrect results could be produced for iterative nonlinear 

direct-integration time-history load cases for models where all degrees of freedom were 

restrained. No other type of load case was affected. The joint displacements for these load cases 

did not necessarily match the applied ground displacements, or were not necessarily zero at 

joints without applied displacement load. Forces and stresses were consistent with the incorrect 

joint displacements. The incorrect displacement results were random and could vary from one 

run to the next. Only models where all degrees of freedom were restrained, whether explicitly 

or implicitly, were affected, which is not a common case. When this occurred, the error was 

obvious in that the joint displacements did not match the specified values, which could be zero. 

Frame Design 
Incidents Resolved 

* Incident Description 

 67836 An incident was resolved where analysis cases with loads that combined load patterns of 

different design types were not being tagged as "seismic" if seismic loads were present. They 

were being tagged as design type "other". This resulted in combinations including these 

analysis cases not being tagged as "seismic" in turn resulting in special seismic conditions in 

design not being triggered. This is not a common condition and would normally occur for 

nonlinear static cases which included load patterns of multiple design types. 

 72147 An incident was resolved for concrete frame design according to the Italian NTC 2008 code in 

which the minimum flexural tensile steel reinforcement of a beam section was incorrect for 

seismic cases. 

 87481 An incident was resolved where for steel, concrete, aluminum, and cold-formed steel frame 

design the framing type may not be reported correctly in the design details under certain 

conditions. This was a reporting issue only. The design was unaffected. 

 89740 An incident was resolved for steel frame design according to AISC 360-10 in which the 

automated load combination that included roof live load was not correct. The load combination 

that includes dead, live, roof live, and wind should have been 1.2DL+1.6RL+/-0.5WL, but the 

program was assigning correct scale factors to DL and RL, and incorrect scale factors of 1.0 to 

the WL and 1.2 to the live load. 

 90063 An incident was resolved for steel frame design according to the Italian NTC 2008 and 

Eurocode 3-2005 codes. The following three issues have been corrected: (1) For Italian NTC 

2008 code only: The Nb,Rd for the angle sections for buckling about major and minor principle 

axes were based on purely K_33*L_33/r_max and K_22*L_22/r_min. They are now based on 

Max(K_33*L_33 and K_22*L_22)/r_max and Max(K_33*L_33 and K_22*L_22)/r_min. (2) 

For both codes: The reporting of the major and minor directions were reversed for the Double 

Angle sections while reporting the basic factors like K and L factors and Nb,Rd forces in the 

design details. (3) For Italian NTC 2008 code only: There was an error in the calculation of 

Weff. This has been fixed. It affected the calculation of Mc,Rd, Mv,Rd, Mn,Rd, and Mb,Rd for 

Class 4 sections. 

 91360 An incident was resolved where the design overwrites for the shear capacities in AISC 360-10 

and AISC 360-05 were not working. The program was always calculating these values. 

 91929 An incident was resolved for steel frame design according to Eurocode 3-2005 in which the 

seismic provision related to the design of joints was incorrectly checked even for DCL 

structures. These special checks are needed only for DCH and DCM structures. 

 94175 

94940 

An incident has been resolved for steel design based on the Chinese 2010 steel frame code. The 

following issues have been corrected/enhanced: (a) The error message "Section is slender" 

referred to several sections of the codes (GB50017 4.3.8, 5.4, GB50011 8.3.2, Table 8.4.1) for 

different types of structural forms and different types of shapes. Another section number (GB 

50011-2010 section 8.4.1.2, Table 8.4.1) has been added to the list. (b) For concentrically 

braced frame, the program was reporting the axial force and the bending moments as zeros in 
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* Incident Description 

the detailed display even though they were non-zero. The error was limited to display only, and 

only for concentric braced frames. (c) The code has a limiting value of 100*(235/Fy) (GB 

50017 5.4.5) for D/t. Whereas the program was using the limit as 100*Sqrt(235/Fy). The square 

root has been removed. 

 95512 An incident was resolved for Eurocode 3-2005 and Italian NTC 2008 steel frame design codes 

where the reported shear areas were switched between major and minor axes. This was just a 

reporting issue and design was not affected. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 

 

87991 

95918 

An incident was resolved where the soil pressure on-screen display was incorrect whenever 

multiple area springs were assigned to an area object. The display was correct only for the last 

spring assigned. All other results accounted for all the springs assigned and were not affected 

with this soil pressure display error. 

 90124 An incident was resolved in which the shell design results did not display if other shell results 

were previously displayed with the option to show as arrows. This was a display issue only and 

did not affect results. This was previously corrected in v18.2.0 but inadvertently omitted from 

the release notes. 

 91438 An incident was resolved where shell thickness overwrites using joint patterns incorrectly 

switched the thickness values assigned to the third and fourth joints of each quadrilateral 

element. For shell objects that were meshed into multiple elements, this error affected each 

individual element. Thickness overwrites specified directly for each node (joint) of the shell 

object were not affected, only those specified by reference to a joint pattern. Triangular 

elements were not affected. Other shell assignments using joint patterns were not affected, 

including joint offsets, temperature loads, and pressure loads. 

 91746 An incident was resolved for steel frame design according to Eurocode 3-2005 in which the 

Shear Details table "Steel Details 3 - Shear Details - Eurocode 3-2005" always showed the 

design shears VsdMajDsgn and VsdMinDesign as equal to one. This was a display problem 

only and design calculations were not affected. 

 95407 An incident was resolved in which the display of shell and solid stresses was not displaying 

arrows for SMax and SMin when requested. This was a display issue only and did not affect 

results. 

 95158 

95451 

95816 

An incident was resolved where the multi-value parameters in the Display Shell Stress form 

were not correctly enabled for enveloping load combinations. This was a user interface issue 

only and did not affect results. 

 95861 An incident was resolved where errors would occur in the advanced report writer if a table 

defined in a saved report was not available or if there was a space at the end of the name of the 

saved report. 

 95918 An incident was resolved where the soil pressure on-screen display was incorrect whenever 

multiple area springs were assigned to an area object. The display was correct only for the last 

spring assigned. All other results accounted for all the springs assigned and were not affected 

with this soil pressure display error. 

Database Tables 
Incidents Resolved 

* Incident Description 

 96565 An incident was resolved where printing tables to a text file from the table display form left off the 

first row of each table and had incorrect values in the units name row. 
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Data Files 
Incidents Resolved 

* Incident Description 

 97180 An incident was resolved where the BSShapes2006.PRO file was defined in incorrect units. 

Imported sections were in millimeters instead of centimeters. 

Application Programming Interface 
Incidents Resolved 

* Incident Description 

 91975 An incident was resolved in the ExternalAnalysisResults.SetFrameForceMultiple API function in 

which an error was returned in certain cases. 

 95470 An incident was resolved in which the API functions New3DFrame, NewBeam, NewSolidBlock, 

and NewWall were not available in the SapModel.File class, although they were documented. The 

functions are now available in the API. 

 97279 An incident was resolved for the Application Programming Interface (API) where the argument 

"Duration" for functions GetStageDefinitions_1 and SetStageDefinitions was declared as Integer 

instead of Double. Similarly, the argument "Age" for functions GetStageData_1 and 

SetStageData_1 was declared as Integer instead of Double. These functions are members of 

SapModel.LoadCases.StaticNonlinear. Values that are set or returned by these functions are 

rounded to the nearest integer. This has been corrected in the newly provided functions 

GetStageDefinitions_2, SetStageDefinitions_1, GetStageData_2, and SetStageData_2 where 

arguments "Duration" and "Age" are declared as Double. The old functions are retained for 

backward compatibility, but use of the new functions is recommended to correct this issue. 

"Duration" and "Age" are specified as days, and the error could be significant for shorter time 

periods using non-integral numbers of days. Analysis results using the old functions will agree with 

the integer number of days actually set and visible in the load case definitions. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 75203 An incident was resolved where exporting a level to SAFE was not working properly. Two issues 

have been corrected. (1) Area springs were not being exported and the user had to manually assign 

them in SAFE. Now area springs of type "Simple" applied to the top or bottom face of the area in 

the normal direction are exported. (2) An error was corrected in the export of loads if both a floor 

and a wall area were being exported with the export option "Floor load and Loads from Above" and 

the floor was internally meshed. 

 94372 An incident affecting the import of Revit projects into SAP2000 was resolved. When a Revit project 

included curved walls, these walls were not imported. When this occurred, the error was obvious 

and the results agreed with the model. Revit curved walls are now imported as a tessellated series of 

plane area objects which approximate the original curved wall geometry. 

 94228 An incident affecting the export of SAP2000 models to Revit was resolved. When a model 

containing line or area objects with a material of a symmetry type other than isotropic was exported, 

SAP2000 wrote an .exr file which CSiXRevit was unable to read. This affected all versions of 

SAP2000 supporting data exchange with Revit. When this occurred, the results were unaffected. 

Line and area objects with a material of a symmetry type other than isotopic are now omitted from 

the .exr files SAP2000 writes, and warnings notifying the user are included in the .exr log file 

SAP2000 also writes. 
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Documentation 
Incidents Resolved 

* Incident Description 

 94544 The Eurocode 2-2004 concrete frame design manual has been updated to document that the 

beam-column joint capacity check is also performed for ductility class medium moment 

resisting frames (DCM-MRF). 

 


